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Adobe Camera Raw - It’s all about having control over processing your image!
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What is a raw format?

• “Raw” data captured by digital camera sensor, before it has been converted to TIFF or JPEG.

• Generally contains incomplete RGB information matching the pattern of RGB pixels contained in the sensor.

• Must be converted in software to create a traditional RGB file.

• Available as optional format on most pro-level and some mid-range cameras.

What do Raw files look like?

• Most sensors capture incomplete red, green, and blue color information.

• Sensor creates single channel that is filtered for different colors at different locations.

• Cameras that create TIFF or JPEG calculate the missing information in-camera.

• When working with raw files, missing information is calculated in post processing using camera manufacturers or third party software, 

allowing more control over conversion settings.

What else is in the raw file?

• Standard EXIF metadata - just like in JPEG’s - Date, time, camera used, etc.

• Camera settings - for example, white balance is not applied to the raw file, but is stored with the file so that camera manufacturer’s software 

can default to the originally intended setting.

• “Special sauce” - additional, custom metadata that the camera manufacturer uses to optimize the quality of their converted files. This is 

typically used to achieve competitive advantage for the camera (or at least perceived advantage).

Benefits of shooting raw files

• Raw files typically smaller than uncompressed TIFF, and without the artifacts of compressed JPEG’s.

• Modify many key camera parameters, such as white balance, even after image is captured.

• Complete control over conversion settings, rather than letting the camera decide.

• Access to 16-bit data for greater detail and fidelity.

• Flexibility of converting a single file using multiple conversion settings.

Original Sensor Incomplete Red, Green and Blue 
channels

Final RGB file
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Photoshop CS2 Camera Raw
With the release of Photoshop CS2, Adobe Camera Raw is built in allowing you to preview the thumbnails of the RAW files (as well as Metadata) 

within the Adobe Bridge. Double-clicking on a RAW image automatically opens the Camera RAW dialog box wherein you can make additional 

adjustments to the unprocessed image.

Multi-file Camera Raw editing and conversion 

You can now select one file and make corrections to it using Camera Raw, or, you can select multiple files and correct them sequentially, or apply 

the same settings to all of them at the same time. In addition, you can process multiple camera RAW image directly into PSD, TIF, JPEG, or DNG 

while simultaneously editing the settings in additional images or while editing images in Photoshop CS2 thanks to it’s new multi threaded 

performance functionality. First we will go through the settings with a single image, then convert multiple images at the same time.  

After double-clicking on a RAW file from Adobe Bridge, the image appears in the Photoshop’s Camera Raw dialog box. In the Image’s Title Bar 

is listed the Camera manufacturer and make, the File name and additional metadata regarding the ISO, aperture, exposure, and lens provided 

that the camera stored that information in EXIF.

The Tools

• The Zoom tool and Hand tool are used for Navigation. Double-clicking on the Zoom tool fits the image in window while double-clicking 

on the Hand tool displays the image at Actual Size (100% zoom). Option (Mac)/Alt (Win) key click with the Zoom tool to zoom out. When 

zoomed into the image use the Hand tool to pan around. 

• The White Balance Eyedropper is used to remove (neutralize) a color cast in an image by setting the image’s color temperature. Position 

and click the White Balance tool in an area of your image that you know should be neutral to automatically set the white balance of the 

image based on that point. Note: it can be helpful to insert a gray card or color chart into the first frame in a sequence of images that are 

shot under the same lighting conditions to remove the guess work from finding a neutral area in images that don’t contain any neutrals. 

In addition, once the first image’s color temperature is properly corrected, the correction can be batch applied to multiple images (more 

on this when we talk about processing multiple RAW images at once). When looking for an optimal “neutral” area in an image to use the 

White Balance eyedropper on, select a bright gray, (around a 1/4 tone or so) - very bright whites are often clipped or start to show sensor 

non-linearities. The White Balance Eyedropper uses a fixed size area to sample and neutralize. The number of pixels that are used depends 

on the zoom level that you’re viewing the image. So the farther you zoom in, the smaller the sample in terms of pixels. Holding down the 

shift key temporarily toggles the White Balance Eyedropper tool to the Color Sampler.

• The Color Sampler tool is used to set sample points in the image to monitor their numeric values as changes are made with other controls 

such as  those on the “Settings” and “Calibrate” tabs. As you add Color Samplers (a maximum of 9 assuming your monitor is large enough), 

the RGB readouts are displayed above the image area. Click and drag to reposition a Color Sampler in the image area.  To delete a single 

Color Sampler, position the cursor over the color sampler while holding the Option (Mac)/Alt (Win)  key. When the icon changes to a pair 

of scissors, click to “cut” (delete) the Color Sampler. Holding down the Shift key temporarily toggles the Color Sampler tool to the White 

Balance Eyedropper 

• The Crop tool allows you to crop away unwanted areas of the image by dragging in the image area around the area that you wish to keep. 

Moving the cursor outside of the crop boundary displays a double headed arrow icon. Click and drag with this icon to rotate the crop to 

straighten images while you crop them at the same time. Click and hold on the Crop icon to display predefined aspect ratios. By default, 

it is set to Normal, meaning that there are no restrictions limiting size or aspect ratio. Select “Custom” to set custom cropping parameters. 

Define ratios with the ratio, inches, or centimeters options or set specific sizes with pixels. To delete a crop select “Clear Crop” from the bot-

tom of the list,  or with the crop tool selected, tap the Escape or Delete key. To drag a crop from the center, hold the Option (Mac)/Alt (Win)  

key. To confine a crop to a square, hold the Shift key. Note: The crop is only applied as part of the overall set of processing instructions to 

the image when it is opened - and is not applied to the original Raw file. After cropping an image in Camera Raw, the preview is updated 

(just as it is for other settings) in the Bridge. 

• Rotate counter-clockwise and clockwise buttons rotate images place a rotate “tag” on each image as necessary. This causes the images to 
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be rotated only when they are opened in Photoshop preventing the need to open and resave the images. 

Display Options

• The Preview button toggles the current/original image settings.

• The Shadows and Highlights checkboxes display clipping warnings to help you visually determine if and where any pixels (in any chan-

nels) are being clipped to pure black or pure white. Shadow areas that are clipped are represented with a blue overlay, and highlights are 

displayed with a red overlay. 

• RGB values are displayed at the top right of the Camera Raw dialog box as you move the cursor over the image.

• A live histogram updates as you change settings using any of the panels and/or as you crop an image.

• A warning icon is displayed (a yellow triangle with an explanation point in it), indicating that the preview is not fully rendered. (Displaying 

a lower resolution image at first allows you to see the image faster, while it renders the high resolution file. )

Workflow Options 

You can choose to show or hide Workflow options including:

• Color space - select from Adobe RGB 1998, Color Match RGB,  Pro Photo RGB or sRGB IEC61966-1. The color space that you choose will 

depend on your workflow.

• Bit Depth - select either 8 or 16 bits per channel. 16 bit will be a larger file, but contains more information and can typically withstand 

greater manipulation than 8 bit images. 

• Size (or crop size if there is a crop on the image) - the width, height and file size values without a plus or minus is the native capture/file 

size of the image, the values with a minus (-) are interpolated down, the plus (+) are interpolated up. Options will vary depending on the 

camera make and model. If the image has a crop assigned, the values are recalculated based on the crop.  

• Resolution - select the resolution for Photoshop to assign to the file. Changing the resolution does not change the file size or dimensions 

(in total pixels) chosen in the Size option, it only distributes the pixels to the selected resolution.

The Adjust Tab

• Select from predefined White Balance settings based on your camera. If, for example, the white balance setting on the camera was incor-

rect when the image was taken, select the correct option. The default settings include: As Shot, Auto, Daylight, Cloudy, Shade, Tungsten,  

Fluorescent, Flash and Custom. 

• If the White Balance preset settings don’t correct your image to your liking , you can use the Temperature and Tint sliders to  modify the 

images color temperature. The Temperature slider modifies from cool (blue, 2000) to warm (yellow, 50000). The Tint slider modifies from 

Green (-150) to Magenta (+150). 

• The Exposure slider is used to set the white point of the image using f-stop values.

• The Shadows slider is used to set the black point of the image using f-stop values.

• The Brightness slider is used to control the gamma of the image (similar to the middle triangle in the Levels dialog box).

• The Contrast slider is used to control the s curve applied to an image to decrease or increase contrast.

• The Saturation slider is used to increases or decreases saturation in the image. Note: even if you lower the saturation to 0, the image will 

still open in RGB although it looks like a grayscale image and each channel is identical to each other.

• Adobe Camera Raw can apply Auto Adjustments using Automatic Image Analysis positioning the Exposure, Shadows, Brightness and 

Contrast sliders based on image data rather than simply according to the camera default (as in previous versions of Camera Raw). When 

checked, these sliders adjust automatically according to changes in the White Balance setting. The Auto Adjustments are complex algo-

rithms and may show clipping depending on the tones of an image. Selecting a larger gamut output space will reduce the clipping. And 

remember, not all clipping is bad, and often a small amount is required to create a useful image.

• To quickly switch the Auto settings on or off, use the shortcut Control (Win)/Command (Mac) +U. 

• All of the Auto settings are on by default. To select which settings use Auto or not, set the Auto checkboxes as desired, then click on the 

fly out menu next to the Settings option and select “Save New Camera Raw Defaults” from the menu. 
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• If needed, you can roughly set the exposure and other setting before setting your white point, then go back and adjust as necessary.

The Detail tab 

The detail tab controls the amount of Sharpening, Luminance Smoothing and Color Noise Reduction applied to an image. View your image at 

100% when applying any of the options in the Details tab - otherwise, you will not see an accurate preview of the changes. 

• Sharpening - use the slider to increase the amount of sharpening on an image.   If you are batch processing a significant number of images, 

and aren’t planning to make further adjustments in Photoshop, you may want to sharpen them as part of the camera RAW adjustment. If 

you are going to open files individually and manipulate them in Photoshop, then you may not want to sharpen in the Camera Raw and, 

instead, sharpen as a last step before printing the image. Note: you can also set your preference to preview sharpening in Camera Raw but 

not apply it (click on the triangle next to the Settings menu and select Preferences...). This allows you to see the effects of sharpening an 

image without actually applying it on open.

• Luminance Smoothing  - aids in the elimination noise in images. This is typically an issue when shooting in very low light situations at 

higher ISO settings. This setting only affects the noise in the gray values of the images. 

• Color Noise Reduction - allows you to eliminate unwanted significantly dissimilar colored pixels by averaging them together. 

• Beware that both Luminance Smoothing and Color Noise reduction will soften the image depending on how strongly they are applied.

The Lens tab 

The Lens Tab corrects imperfections inherent to camera lenses such as Chromatic Aberrations and Vignetting.

• Chromatic Aberration compensates for color misalignment in the image due to the lens. The wider angle the lens, the more noticeable 

the fringe. The Fix Red/Cyan Fringe slider modifies the pixels in the corresponding channels to better align them along the Red/Cyan 

continuum where as the Fix Blue/Yellow Fringe slider modifies the pixels in the corresponding channels to better align them along the 

Blue/Yellow continuum.

• To correct Vignetting, use the Amount slider to either add or remove (lighten or darken) a vignette. Moving the Vignetting Amount to the 

right makes the edges of the image lighter, moving it to the left, makes them darker. Change the midpoint (or the diameter of the vignette) 

using the Vignetting Midpoint slider. Moving the slider to the left brings the midpoint in towards the center of the image, moving it to the 

right spreads the midpoint farther towards the edges of the images. 

The Curve tab

Applies a tonal curve to your Raw images. Use the Tone Curve presets or create your own custom curve.

• The Input and output numbers give numerical feedback as to the change that you are making to any one point on the curve. The input 

level is the before level of the value in the image, the output is the value that it has been changed to as a result of the curve. 

• Linear Curve - this is the default straight line curve that makes no changes to your image

• Medium Contrast - pushes some of the darker  values in an image down on the curve while maintaining the lighter values. 

• Strong Contrast- amplifies the medium contrast curve above

• Custom - create your own curve by adding up to 16 points on the curve for the most precise tonal adjustments. You’ll notice that as soon 

as you make any modifications to the preset curves, the Tone Curve reads “custom”. 

• Save tone curves via the “Save Settings” and/or “Save Settings Subset” flyout menu to the right of the Settings drop down. Name the set-

tings and click Save. After saving tonal curves, they appear in the Tone Curve drop down list.

• Any curve adjustment is applied after any changes made in the Settings tab.

The Calibrate tab

The Calibrate tab allows you to adjust the default settings for each specific camera model. This can help make up for a miscalibrated camera, 

can be used to fix lighting issues, and also to fix camera metamerism problems, and for “preferred color renderings” (inaccurate reproductions 

that look better). These advanced adjustments allow professionals to more precisely profile their individual cameras. 

You cannot add profiles which will appear in this list, however, you can make the adjustments that you desire,  and then save them using the 

“Save Settings” or “Save Settings Subset” options from the flyout menu to the right of the Settings drop down. 
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Opening and/or Saving Files and Setting

 At the bottom right of the Camera Raw dialog, there are a variety of different options to apply (or not apply) settings, open files and save. The 

default options will change depending on if you selected File > Open (or double clicked on the file) or if you selected File > Open with Camera 

Raw. If you double-click, or select File > Open:

• Save... - saves a copy of the processed image (without opening it in Photoshop). Use the Save Options dialog, to select a destination to 

save the file. Use the options in the File Naming area to change file names, add sequencing and choose between upper and lowercase file 

extensions. Use format to select the File type and associated options.  Note that there is built in support for DNG as one of the file formats. 

This feature enables a file to be saved as a background process as you continue to work on other images. 

• Open - opens the file into Photoshop for you to begin working.

• Cancel - cancels any changes made to the settings in Camera Raw and drops you in Photoshop.

• Done - saves any changes made to the settings associated with a file, closing camera raw and dropping you in Photoshop. 

Holding down the Option/Alt key changes the Save, Open and Cancel options:

• “Save...” changes to “Save” (with out the ellipse) which saves the image bypassing the Camera Raw Save Options dialog (it automatically 

uses the last  settings).

• “Open” changes to “Open Copy” which opens a copy of the image. This would be useful for opening multiple copies of the same file 

processed in different ways.

• “Cancel” changes to “Reset” which reverts the image settings to the beginning of the session (not the camera defaults, the image settings 

- although this might be the same if it’s the first time the image is opened in camera Raw). 

If you choose File > Open (or Control (Win)/Command (Mac) +R) to open Camera Raw files in the Bridge you are able to edit Raw files with 

out having Photoshop open.  If you choose to edit raw files in the Bridge, the default button when you’ve made your changes is “Done” and 

clicking it takes you back into the Bridge. 

 Shift-double clicking on a  RAW image in the Bridge will bypass the Camera Raw dialog, applying either settings that have been saved with 

the file, or if there are no setting applied, opening the file with the camera defaults.

Working with multiple images

You can now select multiple Raw files in the Bridge (or from within Photoshop’s open dialog) to work with simultaneously in Camera Raw. 

• Thumbnails are displayed on the left side of the window in a filmstrip.

• Select one or more image thumbnails to edit settings or cropping for those selected thumbnails.

• When editing multiple images, a trash can icon is added to the top list of tools for deleting files.

• If you  open multiple files into Camera Raw but have only one selected and make changes to it, you can then select the others and syn-

chronize multiple images by selecting their thumbnails in Filmstrip mode and clicking the “Synchronization” button. 

• If modifying multiple images at one time in Camera Raw (depending on the speed of your processor), you may see an icon (a yellow 

triangle with an exclamation point in it) warning you that camera Raw is still creating the Preview for that image or image’s thumbnail. As 

soon as it is finished rendering the information, the icon automatically disappears. 

• When  you have multiple images selected in camera Raw, use the click through icon at the bottom of the image area to step through 

selected images in the filmstrip. Note: if only one image is selected, the click through will move through all of the images. 

• Don’t forget, while in Camera Raw with multiple images, you can still apply labels and ratings as well as delete images. 

The options for saving and opening files will change depending on how many files you have selected in Camera Raw. 

• If you have one image selected, then you have the option to Save 1 Image or Open 1 Image. If you have two selected you have the option 

to Save 2 Images or Open 2 Images, etc.  

• When you choose to save images as different formats (DNG, PSD, TIFF or JPEG) Photoshop does this as a background process so that you 

can continue editing and adding files to be processed  as you modify them. 

• File names are automatically incremented to prevent accidental overwrites (useful when saving multiple conversions of a single image)
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• While you’re processing files in Bridge, you can click on the  hyperlink to see the status of the files. 

• In the Save dialog box, the upper and lowercase extensions for all supported formats are listed in the File Extension popup.  (Previously 

this control was just a case selector).  Hence you can now use this control to change the output format also, or use the existing “Format” 

popup lower in the dialog box.

Raw images that have been adjusted and/or cropped are displayed with feedback icons so that the user knows that changes have been made 

in both the Filmstrip mode in Camera Raw as well as in the Bridge if the Bridge icons are set large enough. 

Settings Presets

Use the Settings to select from 4 presets using the drop down menu:

• Camera Default - these are the original settings in the Raw file

• Image Settings - refer to any settings that have previously been applied to the Raw file either from a previous adjustment made within 

Camera Raw or if adjustments have been made since opening the file into Camera Raw.  For images that haven’t been previously opened, 

the Image Settings will be the same as the Camera Default. Once the settings for an image have been modified in Camera Raw, when the 

image is opened for a second time, the Image Settings and Camera Defaults will differ from one another. 

• Previous Settings - Uses the  settings that were applied to the previous image.

• Custom - as soon as you make any changes, you are then working with a custom setting.

Saving Custom Settings

When working with Camera Raw settings, you can save settings to use on other images by clicking the black triangle next to the Settings 

pull-down. These can help save time when batch processing multiple images that were taken under the same lighting conditions or that need 

the same adjustments. 

• Load settings - Loads previously saved setting.

• Save settings - Allows you to save out setting to reuse later .

• Save Settings Subset - Allows you to save out a subset of settings (this can be very helpful when saving a sharpening preset for batch 

processing, saving multiple tonal curves based on image content to apply to multiple images, or saving a chromatic aberration adjustment 

to use with a specific lens.) Note that you can now save a crop as part of a setting subset. This is also a great way to save multiple combina-

tions of curves, saturation, and exposure to mimic a certain type of look normally achieved when shooting film. 

• Delete Current settings - Allows  you to delete settings that have been saved and are loaded. (Select the desired setting to delete it). 

• Export Settings - Saves out “side car” files. This basically exports the settings information to external files for use in other applications or 

when using scripting functions in Photoshop.

• Set Camera Default allows you to customize the default settings for your camera, and save them so that every time you open an image, 

you’ll see the customized default settings for that camera. If you’re working with multiple manufacturers cameras, you can set up defaults 

for each model. 

• Reset Camera Default - Resets the default back to the camera manufacturer’s settings.

• You can save out custom settings to an external file for more efficient collaboration or sharing between machines. 

Applying/Removing Settings from the Bridge

You can apply camera raw defaults, apply the previous conversion, copy, paste or clear Camera Raw setting by selecting Edit > Apply Camera 

Settings in the Bridge.

Preferences

Customize the Camera Raw preferences for Saved Settings, Sharpening and Cache. 

•  Select “Save Image settings in Sidecar xmp files or in Camera Raw Database” to save your modified settings (remember, Photoshop doesn’t 

save back to Raw files so when you make changes, Photoshop will store that information somewhere, either in individual sidecar files which 

automatically travel with the files when you move them using Adobe Bridge, or in a centralized database). This centralized database is 

stored by default on Windows in the location: Application Data /Adobe/Bridge/Thumbnails, and on Macintosh: Users/Library/Application 
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Support/Adobe/Bridge/Cache.

• “Apply sharpening to All Images or Preview images only” - you can choose to apply sharpening to all of the images on opening them 

(depending on the sharpening setting set in the Sharpening, Luminance Smoothing, or Color Noise reduction option in the Detail tab of 

the Camera Raw dialog), or choose to apply them to Preview images only. If you choose to apply them to Preview images only, you will 

see the results of the Detail tab in Camera Raw, but none of the settings will be applied when the file is opened. This might be useful if 

you want to determine if the image you’re working on is appropriate for sharpening, but wait to apply it until all modifications are made 

in Photoshop. 

• Camera Raw Cache - set  the maximum size for the cache, purge cache if needed, and select the location for the Cache. This cache makes 

it faster to switch between (and update) the thumbnails in the Camera Raw filmstrip when two or more images are selected and opened 

into Camera Raw, and to update the thumbnails and previews in Bridge in response to settings changes.

Metadata

When you open a raw file and save it as another format, Photoshop keeps track of the settings that you used when opening the original Camera 

RAW file as part of the newly saved     file’s metadata. 

DNG - The Digital Negative Specification - http://www.adobe.com/products/dng

Raw file formats are becoming extremely popular in digital photography workflows because they offer creative professionals greater creative 

control. However, cameras can use many different raw formats — the specifications for which are not publicly available — which means that 

not every raw file can be read by a variety of software applications. As a result, the use of these proprietary raw files as a long-term archival 

solution carries risk, and sharing these files across complex workflows is even more challenging. 

The Digital Negative (DNG), a new, publicly-available archival format for the raw files generated by digital cameras addresses the lack of an 

open standard for the raw files created by individual camera models. The goal of DNG is to help ensure that photographers will be able to 

access their files in the future. 

In addition to announcing the Digital Negative, Adobe announced the availability of the free Adobe DNG Converter for Windows® and Macintosh, 

which easily translates raw files from many of today’s popular cameras. Software developers and manufacturers can download the complete 

DNG specification (PDF: 276k) from www.adobe.com. DNG is supported by both Adobe® Photoshop® CS and Adobe Photoshop Elements 3.0 

(Windows® & Macintosh) software. To Find out more: Read “Introducing the Digital Negative specification” (PDF: 78k) or “Introducing the Digital 

Negative specification: Information for Manufacturers.” (PDF: 129k) available on www.adobe.com.

The key information for photographers is: 

• The DNG format helps promote archival confidence since digital imaging software solutions will be able to open your raw files more easily 

in the future because the file format is open.

• A single raw processing solution enables a more efficient workflow when handling raw files from multiple camera models and manufac-

turers.  Rather than opening separate applications for each file depending on the camera manufacturer, you can use one.

• A publicly documented and readily available specification can be easily adopted by camera manufacturers and updated to accommodate 

future technological changes. 

The benefits for hardware and software manufacturers: 

• DNG removes a potential barrier to new camera adoption since raw files from new models will be instantly supported by Photoshop and 

other applications. 

• The DNG format allows for R&D savings by eliminating the need to develop new formats and simplifying camera testing.  

•  A common format allows for greater control over the quality of conversions by third-party applications. 

•  The specification allows for the addition of private metadata to DNG files, enabling differentiation. 

For additional information and to hear what existing customers are saying, please visit the User to User Forums - www.adobe.com/forums/


